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INTRODUCTION 

Many sales organizations accelerate deals and increase margins by integrating Oracle CPQ Cloud to their 

Customer Relationship Management (CRM) system. This allows sales reps to get quotes in front of their 

customers quickly and accurately without help from their support staff. Microsoft Dynamics 365 for 

Sales (CRM) customers can integrate with Oracle CPQ Cloud, allowing their users to access CPQ Cloud 

from an Opportunity to create new quotes and edit existing quotes with a seamless Single Sign-On 

experience. Quote data and line items are then synced back to Dynamics.   

Setting up the integration is simplified by installable integration packages delivered and supported by 

Oracle. The data integration is extensible and configurable using BML-based integrations, which build on 

the user integration for Azure Active Directory and improvements to the urlData BML function that 

allow the use of a session token and the Patch method.  

PURPOSE 

The purpose of this implementation guide is to provide administrators with the steps they must 

complete in CPQ Cloud and Microsoft Dynamics 365 to prepare for a CPQ Cloud – Dynamics 365 

integration.   

AUDIENCE 

This implementation guide is intended for the administrators responsible for setting up and configuring 

the integration. This guide assumes administrators have prior CPQ Cloud and Dynamics 365 

administration experience. 

PREREQUISITES 

The following is a list of integration prerequisites:  

• CPQ Cloud Release 18A or later site   

• Dynamics 365 version 9.0 or later   

IMPORTANT: New customers planning to integrate CPQ Cloud with Dynamics 365 should request the 

provision of a Base Reference Application as their initial site image and open a Service Request (SR) on 

My Oracle Support to specify Dynamics 365 as their CRM provider. The BML type integration option is 

then available on the Select Integration Types page. When the integration type is enabled, 

administrators can create an unlimited number of BML integrations for Dynamics 365. 

https://support.oracle.com/


 

MICROSOFT DYNAMICS SOLUTION TO CONNECT CPQ CLOUD 

Administrators must configure Dynamics 365 to support the integration with CPQ Cloud. Oracle provides 

a Dynamics Solution that provides a number of components that support the ability to create and edit 

quotes from an Opportunity. The following table identifies the components included in the Dynamics 

Solution.  

 
Component  

 
Description 

Oracle Quote Entity The representation of a CPQ Commerce Transaction, 
appearing as a list on the Opportunity page. This entity is 
where new quotes are created from and shows a list of any 
previously created quotes. Clicking a quote in this list opens 
that record for editing. 

CPQ Site Settings Entity Allows administrator to supply a number of parameters for 
retrieval by the integrated CPQ Cloud site. 

Opportunity Entity The representation of the Dynamics 365 Opportunity, which stores 
the Oracle Quotes displayed in the Oracle Quote entity. 

CPQ Admin  The Admin security role name. 
CPQ Admin Field Security Profile Gives create, update, and delete rights to the Opportunity, 

Oracle Quote, and CPQ Site Settings. 
CPQ Sales  The Sales security role name. 
CPQ Sales Field Security Profile Gives create, update, and delete rights to the Opportunity and 

Oracle Quote and read access to CPQ Site Settings. 
Web Resources Includes the following: 

 
• CPQ iFrame Loader: Display name of the javascript supports 

the display of the Oracle Quote page within an iFrame in 
Dynamics 365 when users create or edit quotes from 
Dynamics 365.   
 

• ocpq_iframe_loader: The API name of the javascript that 
assists with the flow for creating and editing quotes. 
 

• ocpq_style: The CSS file that styles the Oracle Quote page 
holding the iFrame.  
 

• ocpq_oq_icon_large: The Oracle Quote icon (32 px)  
 

• ocpq_oq_icon_small: The Oracle Quote icon (16 px) 
 

• ocpq_oa_icon_large: The CPQ Site Setting icon (32 px) 
 

• ocpq_oa_icon_small: The CPQ Site Setting icon (32 px) 
 



 

DOWNLOAD THE DYNAMICS SOLUTION 

Download the Dynamics Solution from My Oracle Support.  

1. Log in to My Oracle Support.   

2. Search for the Oracle CPQ Cloud Connector Solution.  

The Doc ID is 2364513.1 

3.  Download the Oracle CPQ Cloud Connector Solution to your computer. 

INSTALL THE DYNAMICS SOLUTION 

Install the Dynamics Solution to expose its components in Dynamics 365.  

Complete the following steps. 

1. Login to Dynamics 365 as an administrator. 

2. Navigate to Settings > Solutions. 

The All Solutions page opens. 

3. Click Import. 

The Select Solution Package window opens. 

4. Click Browse to navigate to the Dynamics Solution. 

5. Click Open. 

The Select Solution Package window displays. 

6. Click Next to install the Oracle CPQ Cloud Connector. 

When installation completes, the Oracle CPQ Cloud Connector is added to the All Solutions 

page. 

 
All Solutions Page Displaying Oracle CPQ Cloud Connector   

IMPORTANT: The Oracle CPQ Cloud Connector components may not be visible until customizations are 

published.  

https://support.oracle.com/
https://support.oracle.com/
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CREATE NEW USERS 

Administrators must manually create new users in the Office 365 Admin center to ensure each 

individual who will use the CPQ Cloud – Dynamics 365 integration is a user in Office 365.   

Complete the following steps: 

1. Sign in to https://www.office.com. 

2. Click Admin app. 

3. Navigate to Users > Active Users. 

4. Click Add a user. 

 

         Add a User Button in Admin Center 

5. Populate all required fields. 

6. Click Add. 

IMPORTANT: In the Password section, you can either force-set a password or immediately enter your 

desired password. 

http://office.com/


 

ASSIGN USERS TO ROLES  

Assign users to the CPQ Admin and CPQ Sales roles included in the Dynamics Solution. The below 

procedure assumes users have already been created in Dynamics 365.  

Complete the following steps: 

1. Open Dynamics 365. 

2. From the Navigation bar, go to Settings > Security.  

 
Security Option in Dynamics 365 Settings 

3. From the Security page, select Users. 

4. Select the user whose roles you want to adjust. 

The User page opens. 

5. Select Manage Roles. 

The Manage User Roles dialog opens. 
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Manage User Roles 

6. Assign users to the roles included in the Dynamics Solution.  

• CPQ Sales: Gives create and update access to the Opportunity and Oracle Quote and read 
access to CPQ Site Settings.  
 

• CPQ Admin: Gives create and update access to the Opportunity, Oracle Quote, and CPQ Site 
Settings. 



 

ADD ORACLE QUOTE ENTITY TO OPPORTUNITY LAYOUT 

Adding the Oracle Quote entity to the Opportunity layout allows a list of Oracle Quotes to display on the 

Opportunity layout.   

Complete the following steps: 

1. Open Dynamics 365. 

2. From the Navigation bar, go to Settings > Customizations. 

The Customization page opens. 

 
Customization Page 

3. Select Customize the System. 

The Information page opens. 

4. Expand the Opportunity entity and select Forms. 

 
Opportunity Forms 



 

10 

 

5. Open the Main form. 

6. From the Insert menu, select Sub-Grid. 

The Set Properties dialog opens. 

 
Set Properties Dialog 

7. In the Name field, specify a unique name for the sub-grid. 

8. From the Records drop-down, select Only Related Records. 

9. From the Entity drop-down, select Oracle Quotes (Opportunity ID). 

10. From the Default View drop-down, select Active Oracle Quotes. 

11. Click OK. 

12. From the Home tab of the form, select Publish. 

The Oracle Quote displays within the active Opportunity. 
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Oracle Quote Entity on Opportunity Layout 



 

EXPOSE CPQ SITE SETTINGS  

A CPQ Site Settings entity is provided for administrators to simplify the setup and integration of their 

company’s instance of CPQ Cloud. Administrators must manually expose the CPQ Site Settings entity in 

Dynamics 365. 

Complete the following steps: 

1. Open Dynamics 365. 

2. From the Navigation bar, go to Settings > Solutions. 

 
Dynamics 365 Navigation Bar 

3. From the All Solutions page, select Oracle CPQ Cloud Connector for Dynamics 365. 

4. From the list of components, select the CPQ Site Settings entity. 

5. Under Areas that display this entity, select Settings. 
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Settings Option  

6. Click Save. 

7. Click Publish. 

IMPORTANT: Assign the user to which you are logged in a role and profile that has access to the CPQ 

Site Settings entity. 



 

CREATE CPQ SITE SETTINGS 

Access the CPQ Site Settings extension in Dynamics 365 to input the necessary settings for the 

integrated CPQ Cloud environment. When creating CPQ Site Settings, administrators are supplying a 

number of parameters that the CPQ Cloud site can retrieve.  

Complete the following steps: 

1. Open Dynamics 365. 

2. From the Navigation bar, go to Settings > CPQ Site Settings. 

 
CPQ Site Settings 

3. From the top left of the Active CPQ Site Settings page, click New.  

The New CPQ Site Settings page opens. 

 

New CPQ Site Settings Page 

4. Populate the following settings: 



 

15 

 

• Name: A descriptive name for the CPQ site to which the settings apply. 

• Site Domain: The root URL of the CPQ site to which the administrator is connecting. 

• Process Name: The variable name of the Commerce process that launches when creating a 

quote. 

• Commerce Process ID: The unique ID of the Commerce process that launches when 

creating a quote. 

• Document ID: The unique ID for the Main Document in the Commerce process. 

• Open Action ID: The unique ID of the Open action used when editing a quote. 

5. Click Save. 

IMPORTANT: When viewing the integration parameters in CPQ Cloud, the CPQ site domain cannot 

contain anything in its path (i.e. no slashes). To view the integration parameters, navigate to the 

Integrations page in CPQ Cloud and click View Parameters. 



 

CREATE DEFAULT SITE SETTINGS FOR ORACLE QUOTES 

Use the Oracle Quote entity to create default site settings for Oracle quotes. This creates a business 

process that sets the default CPQ Site Setting for all Oracle Quotes. 

Complete the following steps: 

1. Open Dynamics 365. 

2. From the Navigation bar, go to Settings > Solutions. 

3. From the All Solutions page, select Oracle CPQ Cloud Connector for Dynamics 365. 

4. From the list of components, select the Oracle Quote entity. 

 
Oracle Quote Entity 

5. Under Business Rules, select New. 
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Create New Business Rule 

6. Populate the condition’s properties, as follows: 

• In the Display Name field, enter a display name for the business rule. 

• In the Entity field, enter Oracle Quote. 

• From the Source drop-down, select Entity. 

• From the Field drop-down, select CPQ Site. 

• From the Operator drop-down, select Does not contain data. 

• The Condition Expression text box auto-populates based on your entries.  
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Default Condition Properties 

7. Click Apply. 

8. Open the Components tab. 

9. Drag the Set Field Value component to the condition's window. 
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Drag Set Field Value Component to Window 

10. Populate the properties for the action, as follows: 

• Display Name: Set Default CPQ Site 

• Entity: Oracle Quote 

• Field: CPQ Site 

• Type: Value 

• Value: Search for a pre-existing CPQ Cloud Site. 
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Action Properties 

11. Click Apply. 

12. Click Save. 

13. Click Activate. 
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Default Site Settings for Oracle Quotes 

EDIT DEFAULT SITE SETTINGS FOR ORACLE QUOTES 

To edit the default site settings for Oracle quotes, open the Oracle Quote entity and deactivate the 

associated process to make it editable.  

Complete the following steps: 

1. Open Dynamics 365. 

2. From the Navigation bar, go to Settings > Solutions. 

3. From the All Solutions page, select Oracle CPQ Cloud Connector for Dynamics 365. 

4. From the list of components, select the Oracle Quote entity. 

5. Navigate to Business Rules and open the process. 

6. Deactivate the process to make it editable. 

7. Click Set Default Value. 

8. Click Value to search for a different CPQ Site Settings record. 

9. Click Apply. 

10. Click Save. 

11. Click Activate. 



 

CPQ CLOUD INTEGRATION PACKAGE TO CONNECT MICROSOFT DYNAMICS  

Administrators must configure CPQ Cloud to connect to their Dynamics 365 instance. Oracle provides a 

Microsoft Dynamics Integration package that administrators can import into a CPQ Cloud site. This 

package contains basic components to integrate a Commerce process with a Dynamics environment. 

When configured, these components integrate data between the systems when users create or update 

quotes in Dynamics 365 or mark a quote as primary and synchronize its data to the Opportunity.  

IMPORTANT: For information about the components included in the Microsoft Dynamics Integration 

package, refer to Appendix A: Microsoft Dynamics Integration Package Components. 

DOWNLOAD THE MICROSOFT DYNAMICS INTEGRATION PACKAGE 

Customers must download the Microsoft Dynamics Integration package from My Oracle Support.  

Complete the following steps: 

1. Log in to My Oracle Support.   

2. Search for the Microsoft Dynamics Integration package.  

The Doc ID is 2364513.1 

3.  Download the package to your computer. 

INSTALL THE MICROSOFT DYNAMICS INTEGRATION PACKAGE 

Use the Migration Center to import and install the Microsoft Dynamics Integration package. 

Complete the following steps: 

1. Open the Admin Home page.   

2. Under Utilities, select Migration. 

The Migration Center opens. 

3. From the Offline Mode drop-down menu, select Import Package. 

https://support.oracle.com/
https://support.oracle.com/
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Import Package Option 

4. From the Upload Package dialog, click Browse. 

Upload Package Dialog 

5. Select the downloaded package from your computer.  

6. Click Open. 

7. From the Upload Package dialog, click Upload.  

 
Upload Package Dialog 

8. Click Migrate. 

The Migration dialog opens. 
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9. (Optional) Enter a Migration Description. 

 
Migration Dialog 

10. Click Migrate. 

11. Monitor the progress of the migration in the Status area at the bottom of the page. 

12. When the migration completes, click Logs at the bottom of the page. 

The Migration Logs window opens and indicates the success or failure of the migration. 

CONFIGURE DATA SYNCHRONIZATION 

Use the “ImportMappings” and “ExportMappings” data tables included in the Microsoft Dynamics 

Integration package to configure data synchronization between CPQ Cloud and Dynamics 365. Default 

mappings are available in these data tables. Administrators can update these mappings, as necessary. 

When Save is clicked from the Oracle Quote page, all mapped fields are saved from CPQ Cloud to the 

appropriate Oracle Quote field in Dynamics 365.  

Complete the following steps to view or modify the default mappings: 

1. Open the Admin Home page. 

2. Under Developer Tools, click Data Tables. 

3. Expand the Integration folder. 

4. Double click the ExportMappings or ImportMappings data table.  

The data table opens and displays the default mappings. 
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SET THE OPPORTUNITY ID 

Administrators must set the mSDYNOpportunityId_t field as the quote's opportunity ID.   

Complete the following steps to set the Opportunity ID: 

1. Log in to CPQ Cloud as an administrator. 

2. Under Commerce and Documents, click Process Definition. 

The Processes page opens. 

3. Navigate to the Commerce process associated with the integration. 

4. From the associated Navigation menu, select Documents. 

5. Click List. 

The Document List page opens. 

6. Click Main from the Document Name column. 

The Add Document page opens. 

7. Enter transaction.mSDYNOpportunityId_t In the Opportunity Id Mapping field.  

8. Click Update. 

9. Deploy Commerce. 
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DEFAULT MAPPINGS - EXPORTMAPPINGS DATA TABLE 

Shown below are the default mappings for the “ExportMapping” data table. 

 
Default Mappings - ExportMappings Data Table 

DEFAULT MAPPINGS - IMPORTMAPPINGS DATA TABLE 

Shown below are the default mappings for the “ImportMappings” data table. 

 
Default Mappings - ImportMappings Data Table 

IMPORTANT: The Dynamics Solution includes an Opportunity entity, Opportunity line items, and a 

Quote entity. For data mapping purposes, entity attributes are referred to as fields.  

 



 

DATA TABLE COLUMNS 

Descriptions of the columns included in the “ImportMappings” and “ExportMappings” data tables are 

provided below. 

Column Name Description 

entity The name of the entity containing the mapped field. Options include: 
ocpq_oracle_quotes, opportunities, and opportunityproducts. 

field The name of the mapped entity field.  

fieldIsReference Indicates whether the field is a Lookup field in Dynamics 365. 

document The level at which the field mapping occurs (e.g. transaction or 
transactionLine). 

attribute The name of the Document or Sub Document attribute to import or 
export. 

process The variable name of the active Commerce process.  

isExternalID Indicates whether the ID for the associated entity is an external ID. 
*Available only in the ExportMappings data table. 

dataType The format in which mapped fields are saved to the Oracle Quote in 
Dynamics 365 during data export. Supported options include Text, 
Floating Point Number, Decimal Number, Currency, Multiple Lines of 
Text, Date and Time, Whole Number (Integer), Option Set, Multi-Select 
Option Set, or Two Option (Boolean). 

  



 

SINGLE SIGN-ON SOLUTION  

CPQ Cloud administrators can use functionality introduced in CPQ Cloud Release 17D to allow Dynamics 

365 users to seamlessly access CPQ Cloud using the integration's Single-Sign On functionality.  

ENABLE OAUTH ON CPQ CLOUD SITE 

OAuth is an industry standard technology that allows customers to grant third-party access to their 

application without sharing their passwords. Administrators must enable OAuth on the CPQ Cloud site 

integrated with Dynamics 365. 

Complete the following steps: 

1. Open the Admin Home page. 

2. Under General, select General Site Options. 

The Options – General page opens. 

3. Set the Enable CRM OAuth option to Yes. 

4. Click Apply. 

INSERT ACCESS TOKEN IN HEADER OF URL DATA FUNCTION 

When integrating CPQ Cloud with a CRM system such as Microsoft Dynamics 365, the integration uses 

an OAuth access token to authenticate user access to the CRM system. Generated automatically when 

the user accesses CPQ Cloud from the CRM system, the token supports the synchronization of data 

between CPQ Cloud and the CRM system.  

CPQ Cloud Release 17D and later allows administrators to use a BML function to retrieve a user's access 

token during a Microsoft Dynamics 365 integrated session. By inserting an access token into the header 

of a BML URL data function, CPQ Cloud can securely write data to Dynamics 365. 

$_access_token_dynamics365$ - For Microsoft Dynamics 365 integrated sessions 

When using OAuth-based Single Sign-On from Dynamics 365 to access CPQ Cloud, the system replaces 

the access token variables above in an "urlData" function with the user's active access token. This 

establishes a secure connection between CPQ Cloud and Dynamics 365.  

For example:  

The header would appear as follows to request a list of Microsoft Dynamics 365 opportunities: 
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NOTES:  

• If the user does not have an integrated session, the access token variable is replaced with a blank. 

• The partner login icon will generate a token for the user as long as the user has generated a token 

and logged in at least once in the past. 

• An invalid or expired access token results in an error from the target system. 

USER INTEGRATION FOR MICROSOFT AZURE ACTIVE DIRECTORY 

The CPQ Cloud and Microsoft Dynamics 365 user integration supports the use of Microsoft Azure Active 

Directory to grant application access to user data. This enhancement provides initial functionality in 

support of a BML-based integration between CPQ Cloud and Microsoft Dynamics 365. Using Azure 

Active Directory as the identify provider (IdP), Microsoft Dynamics 365 users can seamlessly access CPQ 

Cloud using the integration's Single-Sign On (SSO) functionality. 

LOCATE YOUR TENANT NAME 

An organization receives a tenant ID upon signing up for a Microsoft cloud service. The tenant ID is used 

as a reference in Azure Active Directory and Microsoft Dynamics 365. The tenant name is the domain 

name of the Azure Active Directory.  

In CPQ Cloud 17D, administrators can configure SSO between Azure Active Directory and CPQ Cloud by 

completing the following steps: 

• Locate your tenant name in Azure Active Directory 

• Create an app registration in Azure Active Directory 

• Define Permissions in Azure Active Directory 

• Prepare the Azure App for CPQ Cloud integration 

• Prepare CPQ Cloud for Azure App integration 

Complete the following steps: 

1. Log in to Microsoft Azure. 

2. Navigate to Azure Active Directory > Domain names. 
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Domain Name in Azure Active Directory 

3. Copy the domain name. 

You will use the domain name (i.e. tenant name) when creating an app registration. 



 

CREATE AN APP REGISTRATION 

Register Microsoft Dynamics 365 in the Azure portal to add the application to the Microsoft Azure Active 

Directory and create an Application ID. The Application ID allows Microsoft Dynamics 365 to receive 

access tokens. 

Complete the following steps: 

1. Log in to Microsoft Azure. 

2. Navigate to Azure Active Directory > App registrations. 

 

Microsoft Azure Portal 

3. Click New application registration. 

A dialog for creating the registration opens. 
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Registration Details 

4. In the Name field, enter a name for the app registration.  

5. In the Application type field, enter Web app / API. 

6. In the Sign-on URL field, enter the following: 

https://<root_domain>/admin/oauth2/dynamics365/oauth_callback.jsp 

NOTE: The Sign-on URL is used to populate the default "Reply URLs". 

7. Click Save. 

DEFINE PERMISSIONS 

Define the permissions to which the Microsoft Dynamics 365 app requires access. Select the following 

options when setting permissions: 

• Application Permissions 

• Delegated Permissions 

• Access CRM Online as organization users 

NOTE: For additional information, refer to the Azure Active Directory documentation. 

https://docs.microsoft.com/en-us/azure/active-directory/active-directory-apps-permissions-consent


 

PREPARE THE AZURE APP FOR CPQ CLOUD APP INTEGRATION 

A Reply URL is the location to which Azure Active Directory sends an authentication response (i.e. token) 

when authentication is successful. Administrators must specify a Reply URL, which is the URL from which 

Dynamics sales users can access CPQ Cloud.  

Complete the following steps: 

1. Log in to Microsoft Azure. 

2. Navigate to Azure Active Directory > App registrations > Your_pre_existing_app.  

3. Click Reply URLs.  

4. Enter the Reply URL for CPQ Cloud, which is typically: 

https://<root_domain>/admin/oauth2/dynamics365/oauth_callback.jsp 

 

Reply URL 

5. Click Save. 

PREPARE CPQ CLOUD FOR AZURE APP INTEGRATION 

Administrators must open a Service Request (SR) on My Oracle Support to enable SSO for a CPQ Cloud – 

Microsoft Dynamics 365 integration. Before doing so, locate the following information and include the 

information in the SR:  

• Client ID  

• Identity Provider URI and Tenant  

• Client Secret  

• Resource URI 

https://support.oracle.com/
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Get the Client Id 
 

A Client ID is a unique ID synonymous with the Application ID that allows Microsoft Dynamics 365 to 

receive access tokens.  

Complete the following steps: 

1. Log in to Microsoft Azure. 

2. Navigate to Azure Active Directory > App registrations > Your_pre_existing_app. 

3. Copy the Application ID. 

 

Application ID 

Get the Identity Provider URI and Tenant 
 

In a CPQ Cloud – Microsoft Dynamics 365 integration, Microsoft Azure functions as a cloud-based 

identity and access management solution. The Identity Provider URI is the domain of the Azure Active 

Directory URL. The tenant is the first path in the Azure Active Directory URL and proceeds the Identity 

Provider URI. Only the Active Directory URLs specified can authenticate users. 

Complete the following steps: 

1. Log in to Microsoft Azure. 

2. Navigate to Azure Active Directory > App registrations. 

3. Click Endpoints. 

4. Copy the OAUTH 2.0 AUTHORIZATION ENDPOINT. 
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OAuth 2.0 Authorization Endpoint 

5. Locate the Identity Provider URI and the tenant. 

• The Identity Provider URI is the domain of the Azure Active Directory URL and looks similar 

to: https://login.microsoftonline.com 

• The tenant is the first path in the Azure Active Directory URL and looks similar to: 

38ef3fd8-dad2-4d94-b186-f508effa50af 

 

Identity Provider URI and Tenant 

NOTE: The tenant ID shown above and the tenant name referenced in the Locate Your Tenant 

Name section are interchangeable. Microsoft accepts both the Azure Portal's domain and the ID 

as acceptable tenants. The values both point to the same location. 
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Get the Client Secret 
 

SSO between Dynamics and CPQ Cloud requires a client secret.  

Complete the following steps: 

1. Log in to Microsoft Azure. 

2. Navigate to Azure Active Directory > App registrations > Your_pre_existing_app. 

3. Click Keys.  

4. Create your key, which will generate your secret. 

• Provide a description for the key. 

• Select Never expires from the Expires menu. 

• Leave the Value field blank. 

 

Key Details 

5. Click Save to generate the client secret. 
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6. Copy the value in plain text and include it in the Service Request (SR) you create on 

My Oracle Support. An Oracle support technician will encrypt your client secret.  

 

Client Secret 

NOTE: Administrators must copy the client secret. They cannot access the client secret at a later 

time.  

Get the Resource URI 
 

The Resource URI is the environment to which the app registration has data access, which is either the 

Dynamics 365 production or sandbox environment.  

Complete the following steps: 

1. Log in to the Microsoft Dynamics 365 site that will use SSO to access CPQ Cloud. 

2. Copy the URL, trimming off everything except the domain.  

For example: https://yoursite.crm.dynamics.com 

ENABLE SINGLE SIGN-ON  

Enabling Single Sign-On allows sales representatives to access CPQ Cloud pages from Dynamics 365. 

Open a Service Request (SR) on My Oracle Support to enable Single Sign-On for your CPQ Cloud – 

Dynamics 365 integration. Include the Client ID, Identity Provider URI, Client Secret, and Resource URI 

from the previous section in the SR. 

https://support.oracle.com/
https://yoursite.crm.dynamics.com/
https://support.oracle.com/


 

BML INTEGRATION TYPE FOR COMMERCE 

CPQ Cloud Release 18A adds a new Commerce Integration type called BML. These BML integrations 

have all the power and flexibility of BML functions and administrators can define and enable them on 

actions under the Integrations tab, similar to SOAP-based Integrations and ICS Integrations. The basic 

BML functions used to send data to Dynamics 365 via RESTful web services are included in the CPQ 

Cloud migration package.  

SPECIFY DYNAMICS 365 AS CRM PROVIDER 

Open a Service Request (SR) on My Oracle Support to specify Dynamics 365 as your CRM provider. The 

BML type integration option is then available on the Select Integration Types page. When the 

integration type is enabled, administrators can create an unlimited number of BML integrations for 

Dynamics 365.  

IMPORTANT: New customers integrating CPQ Cloud with Dynamics 365 should request a Base 

Reference Application provisioned as their initial site image. 

CREATE BML INTEGRATIONS 

Create a BML integration for each Commerce Library Function included in the Microsoft Dynamics 

Integration package. Administrators have the option of adding additional custom integrations. 

Complete the following steps:  

1. Open the Admin Home page. 

2. Under Commerce and Documents, select Process Definition. 

The Processes page opens. Once enabled, the BML type integration is available across all 

existing and newly created processes on the site. 

3. From the Navigation menu next to the target process, select Integrations. 

4. Click List. 

The Integrations page opens. 

5. Click Add. 

The Select Integration Types page opens. 

6. Select the BML option. 

https://support.oracle.com/
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Select Integration Types Page with BML Option 

7. Click Next. 

The Edit Integration page opens. 

 
Edit Integration Page 

8. In the Name field, enter a name for the BML integration.  

For example: Import Quote Data, Export Quote Data, Export Line Data, or Upsert Primary Quote 

Info. 

9. The Variable Name field auto-populates upon clicking in or tabbing to the field.  

10. (Optional) In the Description field, provide a description of the integration. 

11. Click Define. 

The Select Attributes page opens. 

12. Select a Commerce Library Function included in the migration package or create a custom 

integration. 

13. Click Next. 

The BML Editor opens. 

14. Enter BML for the Commerce Library Function. 

The following screenshots provide sample BML for the various Commerce Library Functions.  
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IMPORTANT: For a better understanding of the sample BML, refer to Appendix B. BML Syntax for 

Commerce Library Functions. 

 
Sample BML – Import Data For Quote Library Function 

 

 
Sample BML – Export Data For Quote Library Function 
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Sample BML – Export Data For Lines Library Function 

 

 
Sample BML – Upsert Primary Flag Library Function 

15. Click Save and Close to return to the Edit Integration page. 

16. Click Save.  

The new BML integration displays on the Integrations page along with all other BML 

integrations.  

IMPORTANT: To update a BML integration, select the integration name from the Integrations page to 

open the Edit Integration page. 



 

MODIFY THE COLLECT QUOTE FIELDS COMERCE LIBRARY FUNCTION 

Add any fields that are mapped in the “ExportMappings” data table to the Collect Quote Fields 

Commerce Library Function. Refer to line 12 for the method with which to add any custom mappings. 

 
Collect Quote Fields Library Function 

 



 

MODIFY THE COLLECT LINE FIELDS COMMERCE LIBRARY FUNCTION 

Add any fields that are mapped in the “ExportMappings” data table to the Collect Line Fields Commerce 

Library Function. Refer to line 16 for the method with which to add any custom mappings. 

 

 
Collect Line Fields Library Function 

 



 

ADD BML INTEGRATION TO NEW TRANSACTIONS 

All BML integrations appear on the Integration tab of the Admin Action page. Administrators must add 

the Import Quote Data integration to new Transactions.  

Complete the following steps: 

1. Open the Admin Home page. 

2. Under Commerce and Documents, select Process Definition. 

The Processes page opens.   

 
Processes Page 

3. Click the name of the target process.  

The Process Administration page opens. 

4. Select the Integration tab. 

5. Move the Import Quote Data integration from the Available Imports column to the Selected 

Imports column. 

 
Import Quote Data Integration in Selected Imports List 

 



 

ADD BML INTEGRATION TO OPEN TRANSACTION PROCESS ACTION 

All BML integrations appear on the Integration tab of the Admin Action page. Administrators must add 

the Import Quote Data integration to the Open Transaction process action.  

Complete the following steps: 

1. Open the Admin Home page. 

2. Under Commerce and Documents, select Process Definition. 

The Processes page opens. 

3. Identify the target process. 

4. From the associated Navigation menu, select Process Actions. 

5. Click List. 

The Process Action List page opens. 

 
Process Action List Page 

6. Click the Open Transaction process action. 

The Admin Action page opens. 

7. Select the Integration tab. 

8. Move the Import Quote Data action from the Integration List to the Selected Integration list. 

 
Import Quote Data Integration in Selected Integration List 

 

 

 



 

ADD BML INTEGRATIONS TO PROCESS ACTIONS 

All BML integrations appear on the Integration tab of the Admin Action page. Associate each of the 

previously created integrations with an action (e.g. New, Import, Save). Administrators can either use 

existing actions or create new ones. Upon activating an integration action, the Commerce “Export Data 

For Quote” BML Library Function calls the “ExportMappings” data table to gather all mapped entity fields 

and their corresponding Document and Sub Document attributes to export. 

IMPORTANT: For additional information about the data tables, BML Library Function, and attributes 

referenced in this section, refer to Appendix A: Migration Package Components. 

Complete the following steps: 

1. Open the Admin Home page. 

2. Under Commerce and Documents, select Process Definition. 

The Processes page opens with Documents displayed by default in the Navigation menu for 

each process listed. 

3. Identify the target process to which the BML integration applies. 

4. Next to the associated Navigation menu, click List.   

The Document List page opens. 

5. Identify the document (i.e. Transaction) or sub document (i.e. Transaction line) containing the 

process action to apply to the BML integration. 

6. From the associated Navigation menu, select Actions. 

7. Click List. 

The Action List page opens. 

8. Select the name of the process action used to invoke the BML integration.  

The Admin Action page opens. 

9. Select the Integration tab. 

The Integration tab determines the order in which data is sent from Dynamics 365 to CPQ 

Cloud. All BML integrations and other CRM integrations display in the Integration tab. 

10. From the Integration List, select the BML integrations to apply to the action. Administrators can 

select and deselect any of the listed integrations. 

11. Move the Export Quote Data, Upsert Primary Quote Info, and Export Line Data BML integrations 

to the Selected Integration list. 

12. Order the BML integrations in the Selected Integration list in the following order: Export Quote 

Data, Upsert Primary Quote Info, and Export Line Data. 
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Order the BML Integrations in the Selected Integration List 

13. Click Apply. 

IMPORTANT:  

• Any action that needs to synchronize data with Dynamics 365 must have the proper integration 

action created. 

• Administrators cannot remove Apply Modify Functions from the Selected Integration list. They 

must order all BML integrations around Apply Modify Functions.  

• Multiple actions can reference the same BML integration.  

• When a BML integration references a process action, administrators cannot delete it.   

• Non-BML integrations are not allowed when a BML integration is applied to a process action. 

Similarly, BML integrations are not allowed when a non-BML integration is applied to a process 

action. An error message will display stating that BML type integrations cannot be mixed with other 

integration types.   



 

CONFIGURE A BML INTEGRATION TO IMPORT DATA WITH PROCESS ACTIONS  

All BML integrations appear on the Integration tab of the Process Administration page. As in prior 

releases, the Integration tab contains a list of integrations available to import into a Transaction at the 

time of creation. With a Dynamics 365 integration, administrators can configure a BML integration to 

import data with process actions.  

Complete the following steps: 

1. Open the Admin Home page. 

2. Under Commerce and Documents, select Process Definition. 
The Processes page opens. 

3. Select the name of a Commerce process.   

The Process Administration page opens. 

4. Select the Integration tab. 

All CRM integrations, including BML integrations, display in the Integration tab. 

 

BML Integrations in Available Imports List  

5. From the Available Imports list, select the BML integrations to apply to the process. 

Administrators can select and deselect any of the listed integrations. 

6. Move the selected integrations to the list of Selected Imports. 

7. Order the BML integrations in the Selected Imports list in any sequence.   

8. Click Apply. 
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MICROSOFT DYNAMICS 365 INTEGRATION ENHANCEMENTS 

As part of continuing improvements to the Microsoft Dynamics 365 integration, the following 

enhancements are available in CPQ Cloud Release 18D: 

• Auto-fill Account information on new Transactions using BML type Account Integrations. 

• Select alternate addresses from the Contact list and populate Bill To and Ship To address sets on 

Transactions using BML type Account Integrations.    

• Synchronize Quote Lines to Opportunity Products as Price List Items. 

• Automatically delete Opportunity Products when a synced Quote is deleted from the 

Opportunity. 

• Utilize improved navigation and framing behavior when opening Oracle Quotes and returning to 

Dynamics 365 from CPQ Cloud. 

UPGRADE THE MICROSOFT DYNAMICS INTEGRATION PACKAGE 

Upgrading the Microsoft Dynamics Integration Package is a prerequisite for setting up the above 

referenced Microsoft Dynamics 365 integration enhancements. 

To upgrade the Microsoft Dynamics Integration Package, perform the below steps. 

1. Log in to My Oracle Support.   

2. Search for the Microsoft Dynamics Integration Package.  

The Doc ID is 2364513.1 

3. Download the package to your computer. 

4. Open the Admin Home page.   

5. Under Utilities, select Migration. 

The Migration Center opens. 

6. Select Import Package from the Offline Mode menu. 

The Upload Package dialog opens. 

https://support.oracle.com/
https://support.oracle.com/
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Offline Mode Menu 

7. Click Browse. 

8. Select the package to upload and the process to upgrade. 

 

Upload Package Dialog 

9. Click Upload. 

The Overwrite Package dialog opens. 

 

Overwrite Package Dialog 

10. Click Yes to import the new package and overwrite the existing package. 

11. From the View menu on the left, deselect the items you have made changes to and do 

not wish to upgrade. 
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View Menu 

IMPORTANT:  

• Upgrading truncates any changes administrators have made to any of the listed items. Deselecting 

items will exclude them from the upgrade and retain any existing customizations, but the new 

features will not be added to your site. 

• If administrators need to override the upgrade on a Commerce function, expand Commerce and 

click the Commerce process.  

12. Click Migrate. 

13. Click Logs when the migration completes to verify a successful migration.  

 

Successful Status to Indicate Successful Migration 
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AUTO-FILL ACCOUNT INFORMATION WHEN CREATING NEW TRANSACTIONS USING BML TYPE 

ACCOUNT INTEGRATIONS 

Administrators can create a BML type Account integration that automatically imports Microsoft 

Dynamics 365 account information into CPQ Cloud when customers create a new Oracle Quote from 

Dynamics 365. 

CREATE BML TYPE ACCOUNT INTEGRATION 

Create a BML type Account integration from the Edit Integration page by selecting the system variable 

and library functions supporting the integration and defining the BML.    

To create a BML type Account integration, perform the following steps: 

1. Open the Admin Home page. 

2. Select Accounts under Integration Platform. 

The Accounts page opens. 

3. Click Integration. 

The Integration for CRM page opens. 

4. Click Add. 

The Edit Integration page opens. 

5. Populate the following fields: 

• Name: A descriptive name for the integration.  

• Variable Name: A unique name for the integration.  

• Description: A simple description of the integration. 

6. Click Add. 

The Edit Integration page refreshes and includes a Define button. 



 

53 

 

 

Edit Integration Page with Define Button 

7. Click Define. 

The Select Attributes page opens. 

8. From the System Variable Name tab, select “_system_account_id_field”.  

9. From the Library Functions tab, select “mSDYNImportAsJson_util” and 

“getMSDYNCalloutSettingsDict_util”. 

10. Click Next. 

BML Editor opens. 

11. Locate the BML for the integration on My Oracle Support.  

Search for Doc ID 2364513.1.  

12.  Copy the BML and paste it into BML Editor. 

13. Click Save and Close. 

https://support.oracle.com/
https://support.oracle.com/
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ADD BML TYPE ACCOUNT INTEGRATION TO THE REFRESH ADDRESS PROCESS ACTION 

After creating the BML type Account integration, add the integration to the Refresh Address action (i.e. 

“_auto_fill_action”) and map the attributes returned by the integration to Transaction attributes. When 

users create a new Oracle Quote in Dynamics 365, the Refresh Address action is invoked and the 

mapped values are added to the Oracle Quote.   

To add the BML type Account integration to the Refresh Address process action, perform the following 

steps: 

1. Open the Admin Home page. 

2. Select Process Definition under Commerce and Documents.  

The Processes page opens. 

3. Identify the target process to which the BML type Account integration applies. 

4. From the associated Navigation menu, select Documents. 

5. Click List. 

The Document List page opens. 

6. Select Actions from the Navigation menu at the Transaction level. 

7. Click List. 

The Action List page opens. 

8. Select the Refresh Address action. 

The Admin Action page opens. 

9. Select the Modify tab. 

10. Set all the attributes you want to auto-populate in the Oracle Quote to Leave Value Unchanged. 

11. Select the Mappings tab. 

All of the attributes available in the CPQ Cloud Account object display. 

12. Map the attributes to Transaction attributes.   

The Refresh Address action retrieves the mapped account values and saves them to the Oracle 

Quote.  
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Sample Mappings 

IMPORTANT: When using the integrated BML, administrators can change field mappings by editing the 

MSDYNAccountMappings table. Each row is a field mapping. The Integration column is set to “account” 

for the BML type Account integration. Enter the Dynamics 365 field name in the Source column. Enter 

the CPQ Cloud account field name in the Destination column. This maps data from the Microsoft 

Account entity to the CPQ Cloud Account object. 

13. Select the Integration tab. 

14. From the CRM Mapping menu, select the name of your BML type Account integration.  

15. Click Apply. 

 

CRM Mapping Menu



 

SELECT ALTERNATE ADDRESSES FROM THE CONTACT LIST AND POPULATE BILL TO AND SHIP TO 

ADDRESS SETS ON TRANSACTIONS 

Administrators can create a BML type Account integration that imports alternate address information 

from the Contact list in Microsoft Dynamics 365 into the Oracle Quote Bill To and Ship To address sets.  

Create BML Type Account Integration 

Create a BML type Account integration from the Edit Integration page by selecting the system variable 

and library functions supporting the integration and defining the BML.  

To create a BML type Account integration, perform the following steps: 

1. Open the Admin Home page. 

2. Select Accounts under Integration Platform. 

The Accounts page opens. 

3. Click Integration. 

The Integration for CRM page opens. 

4. Click Add. 

The Edit Integration page opens. 

5. Populate the following fields: 

• Name: A descriptive name for the integration.  

• Variable Name: A unique name for the integration.  

• Description: A simple description of the integration. 

6. Click Add. 

The Edit Integration page refreshes and includes a Define button. 

 

Edit Integration Page with Define Button 
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7. Click Define. 

The Select Attributes page opens. 

8. From the System Variable Name tab, select “_system_account_id_field”.  

9. From the Library Functions tab, select “mSDYNImportAsJson_util” and 

“getMSDYNCalloutSettingsDict_util”. 

10. Click Next. 

BML Editor opens. 

11. Locate the BML for the integration on My Oracle Support.  

Search for Doc ID 2364513.1.  

12.  Copy the BML and paste it into BML Editor.  

13. Click Save and Close. 

ADD BML TYPE ACCOUNT INTEGRATION TO THE SELECT ALTERNATE ADDRESS PROCESS ACTION 

After creating the BML type account integration, add the integration to the Select Alternate Address 

action (i.e. “_select_alternate_address_action)” and map the attributes returned by the integration to 

Transaction attributes. When users create or edit an Oracle Quote in Dynamics 365 and select an 

alternate address from the Contact list, the Bill To and Ship To address sets on the Oracle Quote are 

populated with the mapped attribute values.  

To add the BML type Account Integration to the Select Alternate Address action, perform the following 

steps: 

1. Open the Admin Home page. 

2. Select Process Definition under Commerce and Documents.  

The Processes page opens. 

3. Identify the target process to which the BML type Account integration applies. 

4. From the associated Navigation menu, select Documents. 

5. Click List. 

The Document List page opens. 

6. Select Actions from the Navigation menu located at the Transaction level. 

7. Click List. 

The Action List page opens. 

https://support.oracle.com/
https://support.oracle.com/
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8. Select the Select An Alternate Address action (i.e. _select_alternate_address_action). 

The Admin Action page opens. 

9. Select the Modify tab. 

10. Set all the attributes to auto-populate in the Oracle Quote to Save From Form. 

11. Select the Mappings tab. 

All of the attributes available in the CPQ Cloud Address object display. 

12. Map the Account Address attributes you want to display in the Oracle Quote to Transaction 

attributes.   

 

Sample Mappings 

IMPORTANT: When using the integrated BML, administrators can change field mappings by editing the 

MSDYNAccountMappings table. Each row is a field mapping. These mappings map data from the 

Microsoft Account Contact entity to the CPQ Cloud Address object. The Integration column is set to 

“address” for the integration. Enter the Dynamics 365 field name in the Source column. Enter the CPQ 

Cloud account field name in the Destination column.  

13. Select the Integration tab. 

14. From the CRM Mapping menu, select the name of your BML type Account integration.  
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15. Click Apply. 

 

CRM Mapping Menu 

 



 

SYNCHRONIZE QUOTE LINES TO OPPORTUNITY PRODUCTS AS PRICE LIST ITEMS 

When users click the Syncing checkbox on a Quote marked as the "primary" or "active" Quote on the 

Opportunity, the line items on the primary Quote are synced to the Opportunity as Opportunity 

products. Prior to CPQ Cloud Release 18D, these products were marked as "Write-in Products". In 

Release 18D, these products can be added as Price List items and the correct Price List is assigned to the 

Opportunity. Administrators cannot manually change the Opportunity Price List after an Oracle Quote is 

created on the Opportunity.   

IMPORTANT: Before line items can be synced as Price List items, administrators must complete the 

procedures in this section. 

Export Price Lists from Dynamics 365 

To export Price Lists from Dynamics 365, perform the following steps: 

1. Log in to Dynamics 365. 

2. Open the Sales menu from the top navigation bar. 

3. Click Settings. 

4. Click the Product Catalog link. 

 

Product Catalog Link 

5. Click the Price Lists link. 
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Price Lists Link 

6. From the Active Price Lists page, click Export to Excel. 

7. Open the downloaded Excel file. 

8. Unhide column A. 

9. Click Enable Editing.  

10. Select all by clicking the triangle in the upper left corner. 

 

Selected Spreadsheet 

11. Right-click the first column header and select Unhide. 
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Unhide First Column 

12. Verify that column A contains an ID. 

 

Column A with ID 

Map Price List ID to Associated Price Book in CPQ Cloud 

Update CPQ Cloud Price Books by mapping the Price List ID to the associated Price Book in CPQ Cloud. 

IMPORTANT: The default 18D Microsoft Dynamics Integration Package assumes there are no Price 

Books. If using a Price Book, administrators must perform the following steps: 

1. Edit the msDYNUpsertPrimaryFlag.bml commerce library in your process. 

2. Add your process’ _partner_price_book_id as quote level input. 

3. Find the pricebook = ""; line in the commerce library. 

4. Change the double quotes to the variable name. 

For example: pricebook = _transaction_partner_price_book_id; 

5. Save the changes to the library. 

6. Deploy Commerce. 



 

To map the Price List ID to the Associated Price Book in CPQ Cloud, perform the following steps: 

1. Open the Admin Home page. 

2. Under Products, select Parts. 

The Part Administration page opens. 

3. Click List in the Price Book area of the page. 

The Price Book Administration List page opens. 

4. Select the name of the Price Book to update. 

The Price Book Administration page opens. 

5. Paste the paired Price List ID into the Partner Price Book Id field. 

6. Click Update. 

7. Repeat the above steps for each paired Price Book. 



 

Specify Unit of Measure 

To create Opportunity line items linked to Dynamics products, administrators must specify a unit of 

measure ID for the Opportunity items. The “commerce.mSDYNExportDataForLines()” library function 

hard codes the unit of measure ID under the variable unit of measure.  Administrators may need to 

update the “uomid” in the “commerce.mSDYNExportDataForLines()” library function to match the unit 

of measure ID in their organization.  

 

To locate the Unit of Measure ID, perform the following steps: 

1. Navigate to [organization URI]/api/data/v9.0/uoms 

For example:  

 

2. Locate “uomid” on the page. 

 

Unit of Measure ID 
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Export Parts from CPQ Cloud 

To export parts from CPQ Cloud, perform the following steps. 

1. Open the Admin Home page. 

2. Navigate to Utilities > Bulk Data Services > Download. 

The Download Category List page opens. 

3. Select the Parts radio button. 

4. Click Next. 

The Search Criteria page opens. 

5. Select CSV as the Download Format. 

6. Enter search criteria to filter the resulting export as desired. 

7. Click Download. 

8. When the download completes, click the Module link on the Download Status page to 

download the results. 



 

Import CPQ Cloud Parts to Dynamics 365 

To import CPQ Cloud parts to Dynamics 365, perform the following steps: 

1. Log in to Dynamics 365. 

2. Under the Sales menu in the top navigation bar, select Settings. 

3. Select Data Management. 

The Data Management page opens. 

4. Select Imports. 

The My Imports page opens. 

5. Click IMPORT DATA. 

The Upload Data File dialog opens. 

6. Select the file containing the parts you downloaded from CPQ Cloud. 

7. Click Next. 

8. Review the mapping dialog. 

 

Mapping Dialog 

9. Click OK. 

10. Click to allow or disallow duplicates and assign an owner for the import. 
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Review Settings and Import Data 

11. Click Submit. 

12. Click Finish. 

Activate Dynamics 365 Products 

The products in the Dynamics 365 site must be active. If the they are inactive, administrators can bulk 

activate the products. For additional information, refer to the Microsoft Dynamics 365 documentation. 

To activate Dynamics 365 products, perform the following steps: 

1. Log in to Dynamics 365. 

2. Open the Sales menu from the top navigation bar. 

3. Select Settings. 

4. Select the Product Catalog link. 

5. Select Families & Products. 

https://docs.microsoft.com/en-us/dynamics365/customer-engagement/developer/publish-revise-revert-retire-activate-products
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Families & Products Link 

6. From the All Products, Families & Bundles page, select EXPORT TO EXCEL. 

7. Save the file. 

8. Open the downloaded spreadsheet. 

9. Set the Status column to “Active” for all products you want to activate. 

10. Save the spreadsheet. 

11. Under the Sales menu in the top navigation bar, select Settings. 

12. Select Data Management. 

The Data Management page opens. 

13. Select Imports. 

The My Imports page opens. 

14. Click IMPORT DATA. 

15. Follow the import wizard’s steps. 

The products are now activated. 
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AUTOMATICALLY DELETE OPPORTUNITY PRODUCTS WHEN SYNCED ORACLE QUOTE IS DELETED 

FROM OPPORTUNITY 

In prior releases, deleting a synced Oracle Quote did not delete the associated Opportunity products. 

When users delete an Oracle Quote that has synced to an Opportunity, all of the associated Opportunity 

products are automatically deleted in Dynamics 365. The CPQ Cloud Transaction is not affected.  

IMPORTANT: To make this enhancement available to users, administrators must Upgrade the Microsoft 

Dynamics Integration Package. No additional administrator action is required. 

SAMPLE USE CASE 

1. Create a new CPQ Cloud Quote from Dynamics 365. 

2. Add line items to the Quote. 

3. Mark the Quote as Primary. 

4. Save the Quote. 

5. Synchronize the CPQ Cloud Quote to a Dynamics 365 Opportunity. 

6. Return to the Opportunity. 

The Opportunity displays a list of Oracle Quotes and the associated Product line items. 

 

Sample Oracle Quotes List 
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Sample Product Line Items 

7. Delete the synced Oracle Quote from the list of Oracle Quotes.  

The associated Product line items are also deleted. 



 

UTILIZE IMPROVED NAVIGATION AND FRAMING BEHAVIOR 

The CPQ Cloud - Microsoft Dynamics 365 integration enhancements provide improved navigation and 

framing behavior when opening Quotes and returning to Dynamics 365 from CPQ Cloud.  

IMPORTANT: To make this enhancement available to users, administrators must Upgrade the Microsoft 

Dynamics Integration Package.  No additional administrator action is required. 

Consistent Window Behavior 

Users create new Oracle Quotes and edit existing Oracle Quotes from the same window. When a user 

created a new Oracle Quote in prior releases, they did so with a pop-up that opened a new window. 

When they later edited that Quote, it opened the Quote in the active window. Oracle has removed this 

inconsistency in 18D, so the new Quote and the edit Quote experience are the same. The user will 

always open a Quote in the active window. 

 

Consistent Window Behavior 



 

Improved Button Bar 

When users created or edited Oracle Quotes in prior releases, the Dynamics button bar displayed 

buttons native to Dynamics 365 that were not applicable to the CPQ Cloud – Dynamics 365 integration. 

With the CPQ Cloud 18D enhancements, the Dynamics button bar no longer displays when users create 

or edit Oracle Quotes. 

 

Improved Button Bar 

Hide Additional Buttons 

As administrators customize their Dynamics 365 instance, they may choose to hide additional buttons 

using the Ribbon Workbench.  

1. Download the latest version of the Ribbon Workbench. 

2. Log in to Dynamics 365 as an administrator. 

3. Open the Settings menu from the top navigation bar. 

4. Select Settings. 

5. Select Solutions. 

6. Navigate to Settings > Settings > Solutions. 

 

https://www.develop1.net/public/rwb/ribbonworkbench.aspx
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Solutions Link  

7. Click Import. 

8. Select the file downloaded in step 1. 

9. Install Ribbon Workbench. 

10. Refresh the page after completing the install. 

The Ribbon Workbench 2016 button at the top of the page indicates a successful install. 

 

Ribbon Workbench 2016 Button 

11. Click Ribbon Workbench 2016. 

12. Select Oracle CPQ Cloud Connector. 

 

Load Oracle CPQ Cloud Connector 

13. Click OK. 
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14. Select the entity to manipulate by navigating to Command Bar > Solution Elements > Entity. 

 

Solution Elements 

15. Right-click the button to hide and click Hide. 

 

Hide Button 

16. Click Publish after hiding all the buttons you want to hide. 
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OPPORTUNITY AUTO-REFRESH ON SAVE 

When users create a new Oracle Quote in Dynamics 365, click Save, and return to the Opportunity, the 

Opportunity auto-refreshes and displays the new Oracle Quote under the Oracle Quotes heading. Prior 

to CPQ Cloud Release 18D, users had to manually refresh the Opportunity page to see the new Oracle 

Quote under the Oracle Quotes heading. 

 

 

 

 

 

 



 

APPENDIX A: MIGRATION PACKAGE COMPONENTS  

The components included in the Microsoft Dynamics Integration package are identified in the below tables.  

Commerce Main Document Attributes 

Attribute Name Variable Name Description 

Opportunity ID mSDYNOpportunityId_t ID of MS Dynamics Opportunity entity record. When a quote is created 
in Dynamics 365, the CPQ Cloud Transaction receives the Dynamics 365 
“Opportunity ID”. 

Quote ID mSDYNQuoteId_t ID of MS Dynamics Oracle Quote entity record 

Quote Is Primary mSDYNIsPrimaryQuote_t Boolean to indicate the Quote is the primary Quote on the Opportunity 
entity record. This tells the system to create Opportunity Line Item 
records when the systems are synchronized. 

Primary Quote ID mSDYNPrimaryQuoteId_t ID of Microsoft Dynamics Oracle Quote entity record that is marked as 
primary on the Opportunity entity record. 

Opportunity Line IDs mSDYNOpportunityLineIds_t List of all line item IDs that exist on the Opportunity in Microsoft 

Dynamics.  

Commerce Sub Document Attributes 

Attribute Name Variable Name Description 

Opportunity ID 

 

mSDYNOpportunityId_l ID of MS Dynamics Opportunity entity record. 

Opportunity Line ID mSDYNOpportunityLineId_l ID of Microsoft Dynamics Opportunity Line entity record. 



 

 

Commerce Library Functions 

Attribute Name Variable Name Description 

Collect Quote Fields mSDYNCollectQuoteFields Function for administrator to update with main document attributes 
mapped in the Import and Export mapping tables 

Collect Line Fields mSDYNCollectLineFields Function for administrator to update with sub document attributes 
mapped in the Import and Export mapping tables 

Import Data For Quote mSDYNImportDataForQuote Imports quote data from Dynamics 

Export Data For Quote mSDYNExportDataForQuote Exports quote main doc data to Dynamics.  
Supports writing to CPQ Quote and Opportunity entities. 

Upsert Primary Flag mSDYNUpsertPrimaryFlag Sets the primary quote id in Dynamics 

Export Data For Lines mSDYNExportDataForLines Exports quote main doc data to Dynamics 

BML Library Functions 

Attribute Name Variable Name Description 

Convert Batch Response To 
Info Pool 

convertMSDYNBatchResponseToInfoPoo
lUtil_util 

Converts batch responses into a dictionary of string dictionaries-
Key[Content-Id(string)]:Value[batch response for a single job(string 
dictionary)] 

Get Callout Settings getMSDYNCalloutSettingsDict_util Gathers information to make internal REST callouts [CPQ for 
Doc/SubDoc data], as well as external [MS Dynamics] 

Get Field Mappings getMSDYNFieldMappings_util Gathers mappings of MS Dynamics entity fields to CPQ doc/subdoc 
attributes 

Get Child IDs mSDYNGetChildIDs_util Queries dynamics for all the child object IDs with a given parent. During 
opportunity product synchronization, this is used to determine what 
products to delete. 

Process Response  processMSDYNResponse_util Takes in the response of a call to create or update a singular entity 
record in MS Dynamics and parses out the ID of the record(SUCCESS) or 
an error message(FAILURE)  

Map JSON Attrs By Type mapJsonAttrsByType_util Takes in a source js object, and maps its values to a target js object, 
while typing and substituting values where necessary.  

Process Import Data mSDYNProcessImportData_util Handles mapping of main doc fields, as we only need to handle syncing 
of quote level data on initial import 



 

Data Tables 

Table Name Description 
CalloutSettings Holds integration settings 
ImportMappings Holds mapping of Microsoft Dynamics entity fields to OCPQ attributes 
ExportMappings Holds mapping of OCPQ attributes to Microsoft Dynamics entity fields 



 

APPENDIX B: BML SYNTAX FOR COMMERCE LIBRARY FUNCTIONS 

Administrators must create BML integrations for the Commerce Library Functions included in the 

Microsoft Dynamics Integration package. Information about the BML syntax administrators must use for 

the various Commerce Library Functions is provided below.   

IMPORT DATA FOR QUOTE 

CPQ Process Variable Name is a string parameter specifying the variable name of the Commerce 

process. Import Mapping Table Name is a string parameter specifying the data table to use for mapping 

Dynamics 365 fields to CPQ Cloud attributes. 

       

 

EXPORT DATA FOR QUOTE 

CPQ Process Variable name is a string parameter specifying the variable name of the Commerce process. 

Export Mapping Table Name is a string parameter specifying the data table to use for mapping Dynamics 

365 fields to CPQ Cloud attributes. 

Data is a JSON parameter holding Main and Sub document data in the function. 

 

IMPORTANT: mSDYNCollectQuoteFields is a Commerce Library function used to place Main document 

fields into a data map for use by other functions.   

 



 

EXPORT DATA FOR LINES 

CPQ Process Variable name is a string parameter specifying the variable name of the Commerce process. 

Export Mapping Table Name is a string parameter specifying the data table to use for mapping Dynamics 

365 fields to CPQ Cloud attributes. 

Data is a JSON parameter holding Main and Sub document data in the function. 

 

IMPORTANT: mSDYNCollectLineFields is a Commerce Library function used to place Sub document fields 

into a data map for use by other functions.   

 

UPSERT PRIMARY FLAG 

CPQ Process Variable name is a string parameter specifying the variable name of the Commerce process. 



 

APPENDIX C: ENTITY FIELDS 

The Oracle Quote entity and CPQ Site Settings entity contain the fields available in the following tables.   

ORACLE QUOTE ENTITY   

The following table identifies the fields available in the Oracle Quote entity. 

cpq_oracle_quote 

 
Field Name 

 
Label 

 
Description 

ocpq_name Name Holds the name of the CPQ Cloud 
Transaction. 

ocpq_oracle_quoteid Oracle Quote Holds the unique identifier for entity 
instances. 

ocpq_opportunity_id Opportunity ID Holds the lookup to the Opportunity 
record.  

ocpq_cpq_site_setting_id CPQ Site Holds the unique identifier needed to 
connect to the correct CPQ Cloud 
instance. 

ocpq_bs_id Buyside ID Holds the Buyside ID associated with the 
CPQ Cloud Transaction.  

CPQ SITE SETTINGS FIELDS 

The following table identifies the fields available in the CPQ Site Settings entity. 

cpq__cpq_site_setting 

 
Field Name 

 
Label 

 
Description 

ocpq_name Name Holds the display name of the CPQ Cloud 
site. 

ocpq_process Process Name Holds the varname of the CPQ Cloud 
Commerce process. 

ocpq_process_id Commerce Process ID Holds the ID of the CPQ Cloud Commerce 
process. 

ocpq_action_id_open Open Action ID Holds the ID of the integration action that 
executes upon entering the Oracle Quote 
page to edit a quote. 

ocpq_document_id Document ID Holds the ID of the CPQ Cloud Document. 

ocpq_url Site Domain Holds the URL of the root domain of the CPQ 
Cloud site.  
Include the https:// 
Note: The CPQ site must have SSL enabled 

ocpq_site_settings_id CPQ Site Settings Holds the unique identifier needed to 
connect to the correct CPQ Cloud instance. 
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APPENDIX D: KEY RESOURCES 

Refer to the following resources for information applicable to the CPQ Cloud – Dynamics 365 

integration: 

• For information about the sales user experience for creating, updating, and deleting CPQ Cloud 

Quotes from within Dynamics 365, refer to the Microsoft Dynamics 365 Integration section of 

the CPQ Cloud Release 18A What’s New Document or the CPQ Cloud Administrator Online Help. 

• For information about Azure Active Directory, refer to the Azure Active Directory 

Documentation. 

• For information about setting up users and roles in Dynamics 365, refer to the documentation 

provided on https://www.office.com. 

 

  

 
 
 
 
 
 
 
 
 
 

https://support.oracle.com/epmos/faces/DocumentDisplay?_afrLoop=287314224034968&id=1674718.1&_afrWindowMode=0&_adf.ctrl-state=11fvn8rjpp_4
https://docs.microsoft.com/en-us/azure/active-directory/active-directory-whatis
https://docs.microsoft.com/en-us/azure/active-directory/active-directory-whatis
http://office.com/
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